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Technical Support

The Bynari Insight products can be purchased with one of the following technical support options includ-
ed: 
• Without Support –30 days of free product maintenance and upgrades.
• With Support – 1 year product maintenance, upgrades and unlimited email and telephone support. 

Support is available to customers worldwide.  

To contact technical support 

Phone 1-214-350-5772 or email: support@bynari.net

For FAQs:  http://www.bynari.net/faq/
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Licensing
The Bynari Insight Connector utilizes a licensing key system that determines the number of licenses that 
have been purchased by the customer. When Outlook is started the licensing agent within the Insight 
Connector will contact your Insight Server (V4.2.3 and beyond) to validate and activate the user licenses. 
If the Connector does not find an Insight Server installed, it will contact the Bynari Key Server over the In-
ternet to validate and activate the installed license. Activation will be attempted each time Outlook is start-
ed until activation of the license succeeds.

If you are validating with the Bynari Key Server, license activation may fail for the following reasons:

• The client systems are blocked from accessing the Internet or Internet access is temporarily unavail-
able.

• The license key entered during the installation of the Insight Connector is invalid.
• The number of client licenses has been exceeded. The Bynari Key Server tracks how many client 

systems have been activated using a given license. If the number of activated clients exceeds the to-
tal for the license the Insight Connector will inform you that additional licenses should be purchased.

• If you need to reinstall the Insight Connector software on a new system due to either hardware failure 
or system upgrade, contact Bynari’s support staff to assist you with removing the existing client’s reg-
istration.  

If you experience problems with license activation please contact your reseller or Bynari sup-
port staff as noted in the beginning of this guide.

Important Notes:  

• This documentation applies to the latest build of the Insight Connector available on the Bynari 
Website.

• Ensure that Outlook is setup as the default e-mail client.   To verify this on the client go to Control 
Panel > Internet Options > Programs and make sure that Outlook is selected in the drop down 
box.

• Please note that the Insight Connector has been tested with our Insight Server only. We do not 
guarantee that any other mail servers will work with our Connector. If you are using another 
IMAP4 mail server with ACL and would like assistance, we will provide our best effort support at a 
rate of $150 per hour. Thank you and enjoy. 
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Insight Connector version 3.1
The Bynari Insight Connector acts as a MAPI transport provider for Microsoft Outlook.  Using the 
Insight Connector, IMAP mailboxes can now operate as full Outlook information stores containing 
any kind of Outlook items such as Appointment, Contact, and Task items instead of limiting to 
messages only.

When Insight Connector is used in conjunction with our Linux based mail server, Insight Server, a 
powerful collaboration environment is created.  Users are able to share mail folders, contacts, 
and calendaring information with other individuals or system wide.  Public folders of each type 
can also be created and maintained by system administrators through the web admin interface. 
All of these functions are supported through the familiar Outlook interface eliminating any need 
for additional costly end user training.

Architecture
Messaging Application Programming Interface or MAPI has two ma-
jor components.  Applications such as Microsoft Outlook use the 
client side interface to contact the MAPI subsystem for all communi-
cations with the message store.  There is also a service provider in-
terface which is used by programs such as Insight Connector to pro-
vide the MAPI transport services for accessing the message store 
on the server.

Insight Connector acts as a transport agent that provides messaging 
services directly to the MAPI subsystem and stores this information 
on Insight Server via the IMAP protocol.

                                                                                                                                             Figure 1 - MAPI Architecture
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Features of Insight Connector 3.1
Insight Connector 3 features include the following:

• Native MAPI implementation
• Simple click-and-go installation and configuration
• Transparent server based licensing
• SSL secure connection support
• Mail, Calendar, Contacts, Journal, Notes and Task folder support
• Native Outlook calendar functions 
• Free/Busy support 
• Global Contact Lists 
• Public Distribution Lists
• Outlook Rules Wizard 
• New e-mail notification 
• Read receipts
• IMAP folder subscriptions
• Shared public and private folders
• Shared folder access controls 
• Header only download 
• Offline support
• Grouping
• Multiple User accounts
• PDA support
• And more …

Supported Platforms
Insight Connector 3.1 is compatible with the following software. If you are running versions that 
are not listed or software that is not supported, you need to upgrade to a supported version.

Supported Windows® Versions

Windows® 2000

Windows® XP

Windows® 2003

Supported Outlook® Versions

Outlook® 98

Outlook® 2000

Outlook® XP

Outlook® 2003
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Supported Languages
• English

• French

• German

• Italian

• Spanish (Spain)

• Portuguese (Brazil)

Note: Other languages are provided and may be used but are not formally supported. 
Problems with translation, spelling, grammar and proper character encoding may be en-
countered.

Known Limitations
• MS Contact Manager is not compatible.

• Multiple accounts in the same profile are not fully supported.  To use pop3 with Connec-
tor, please have pop3 account installed first.

• PDA synchronization is dependent on the hardware and the software provider. 

• Outlook stationary is not supported.

• iCalendar meeting requests are not supported. 

• Slashes in folder names are not allowed.

• GIMP is not compatible due to a DLL conflict.
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Installation
Before you can install Insight Connector 3.1, you need to set the environment on your computer. 
This requires that you have the supported software with the latest updates installed on your com-
puter.

Preparing Your System (Pre-Installation)

Before you begin:
• The Connector 3.x software must be installed by the Windows login user. Additionally, 

this user must have administrative rights to install the software. The users’ rights can be 
changed to install Connector 3.x and then reset to the original rights.

• If you are using Outlook 2000, you may be required to insert your original Outlook 
installation media. Make sure that you have your original Outlook installation media or 
that the original software is available via a network share before you attempt to change 
your Outlook configuration. 

Before you begin the installation procedure, you need to perform the following steps:

Step 1: Install Microsoft® Windows® and/or Microsoft® Outlook®

I Connector 3.x is compatible with the Microsoft® Windows® and Outlook® versions listed below. If 
you are running versions that are not listed you need to upgrade to a supported version.

Supported Windows® Versions

Windows® 2000

Windows® XP

Windows® 2003

Supported Outlook® Versions

Outlook® 98

Outlook® 2000

Outlook® XP

Outlook® 2003

Step 2: Install the Latest Updates for Microsoft Windows® and Outlook®

Go to the Microsoft® website or check with your IT Administrator to verify that you have installed 
the most current critical updates and Service Packs for both your Windows operating system and 
Outlook.

Step 3: Configure Outlook® for Corporate or Workgroup service

Note: This step only applies to Outlook 98 and 2000

To check which service is configured:
1. Open Outlook 98/2000.

2. Go to Help  About Microsoft Outlook.

3. Verify Outlook is configured for ‘Corporate or Workgroup’ not ‘Internet e-mail’ service. If 
Outlook is not configured correctly, you need to change the service configuration.
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To change the service for which Outlook is configured:
1. Open Outlook 2000.

2. Go to Tools  Options  Mail Delivery.

3. Click Reconfigure Mail Delivery. 

4. Select ‘Corporate or Workgroup’.

5. If you are instructed to restart Outlook go ahead and restart it. When Outlook starts a Wizard 
may appear to help you create a new profile or email account. Cancel out of the Wizard.

6. Close Outlook.

Step 4: Set Outlook as the default e-mail client

Outlook must be set as the default e-mail client for Windows.

To set Outlook as the default e-mail client:
1. Go to Start  Control Panel  Internet Options  Programs.

2. Select Microsoft Outlook from the drop-down menu in the E-mail program box.
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Installing Insight Connector 3.1
These steps explain how to install and configure the Insight Connector 3.1 for Microsoft Outlook.

Note:  The Bynari  Insight Connector will  only install  on systems where the user has 
administrative rights. The users’ rights can be changed to install the Bynari Insight-Con-
nector and then reset to the original rights.

1.  Verify that Microsoft Outlook is installed with all of the latest Service Packs and Critical up-
dates; if it is not, install it at this time.

Note: If Outlook has not been previously installed, it is recommended that you do not 
create any user profiles at this time.  If Outlook has been installed previously and a user 
profile has been created it is recommended that you create a completely new profile.

2.   Ensure that Outlook and any other unnecessary programs are closed before installing the In-
sight Connector.

3.   Locate and launch the executable file for the Insight Connector installer package as shown in 
Figure 2.

Figure 2 - Insight Connector Installer Package

4.   After the setup initializes the “Welcome” dialogue box will appear, click “Next >”.

5.  Read the license agreement and if you agree, select the radio button “I  accept the license 
agreement” and click “Next >”.

6.   The next dialogue box will ask for confirmation of the destination of the program files.  At this 
time you may choose a different location other than default, browse to the directory and se-
lect “Next >”.

7. If you are upgrading from Insight Connector 3.x then you will see the dialog “Folder Exists” 
prompting you “Would you like to install anyway?’.  Select “Yes” to continue.

8.   In the next dialog choose whether you would like the Insight Connector toolbar visible or hid-
den.  It is recommended that you do not hide the toolbar. However if you do, you can always 
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make it visible again. (Section titled Using Insight Connector of this document covers normal 
operations and describes how to change more settings) Click “Next >”.

9.   Review configuration settings and select Install.

Figure 3 - Select Review Configuration settings

9.  After the connector is successfully installed a final dialog will appear, click “Finish”.   The in-
stallation portion of the connector is now complete.  Now you will need to configure Outlook to 
take advantage of the Insight Connector.
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Outlook and Insight Connector Configuration
This section describes how to configure Outlook to best use the Insight Connector.

It is considered best practice to create an additional profile in Outlook when installing the Insight 
Connector.  As with any upgrade process you should also backup you existing Outlook PST to 
ensure that no data loss will be experienced due to the installation problems should they occur.

Note:  When installing Insight Connector in addition to another POP3 account type, you must in-
stall the Insight Connector account type first.  Installing a POP3 account type before the Connec-
tor account will result in an error during the installation process of the Connector.

While creating a profile using the steps below, Outlook will be using a wizard for most of the 
steps.  Microsoft has developed the creation of profiles to be very user friendly, so only one win-
dow (even if there are many being used) will be active. 

Follow the steps below for your specific version of Outlook;

For Outlook 98 and 2000:

Note:  If you use Outlook 98 or Outlook 2000 ensure that it is configured to run in the "Corporate 
or Workgroup mode". To check this, start Outlook, and select “Options” from the Tools menu. 
The Options dialog box appears. Select the “Mail Services” tab and click the “Reconfigure Mail 
Support” button to open the E-mail Service Options dialog box. Check that the “Corporate or 
Workgroup” option is selected.

The MS Office installation CD-ROM might be required to complete Outlook mode switching.

1. For new installations of Outlook, double click the Outlook icon and the Add Profile Wizard will 
automatically start.   For users with existing Outlook installations,  open the Microsoft  mail 
properties dialogue box by right-clicking the Outlook icon on the desktop and choosing “prop-
erties”

2. On  the  Services  Tab  at  the  bottom of  the  windows,  select  the  button  that  says  “Show 
Profiles”.

3. Now select the “Add” button.

4. In the box titled Microsoft Outlook Setup Wizard, select the check box next to “Bynari Insight 
Connector 3.1:” and then click “Next”.
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Figure 4 - Adding a new e-mail account to a profile

5. Now enter the name for your Insight Connector Profile and select Next.

Figure 5 – Enter profile name for Outlook Setup Wizard

Outlook 2000 users should now skip ahead to the section titled: 
             “Insight Connector 3.1 Connection Properties”
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For Outlook 2002 and 2003:

1. Close Outlook

2. For new installations of Outlook, double click the Outlook icon and the Add Profile Wizard will 
automatically start.   For users with existing Outlook installations,  open the Microsoft  mail 
properties dialogue box by right-clicking the Outlook icon on the desktop and choosing “prop-
erties”.

3. With the properties page open, select the “Show profiles” button.

4. Select “Add…” on the Mail Profiles dialog box and you will be prompted for a profile name 
and The Microsoft Outlook Setup Wizard will now run. 

5. In the setup wizard select “Add new e-mail account” (Figure 6) and click “Next >”.

Figure 6 - Adding a new e-mail account to a profile

6. The next screen in the setup wizard is for choosing the new account type.  Under Server 
Type click “Additional Server Types” and then select “Next >”.
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Figure 7 – Additional Server Types

7. In the dialog box titled “Additional Server Types” select the Bynari Insight Connector 3.1 and 
click “Next >”. 
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Insight Connector 3.1 Properties
The following sections describe the configuration settings for Insight Connector 3.1 regardless of 
the version of Outlook installed.  These properties not only define account information but also de-
termine the connection type used to contact the Insight Server over the network.

This information should be provided by the Insight Server administrator.

 
Figure 8 - General tab properties
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General

Under the general tab, you will find two sections: User Information and Account Settings.  All of 
this information is required.

a. User Information section describes the user, company, and user’s email address. 

b. Account Settings provides Insight Connector with the server connection properties 
and account login information. 

• Display Name: Determines the root folder display in Outlook’s folder view.

• Server Information: Provides Insight Connector with both the IMAP and SMTP 
server addresses.  This can either be the IP address or Fully Qualified Domain 
Name (FQDN) for the server.  These entries generally are either the IP address 
or name of the Insight Server; however, this may vary depending on your envi-
ronment.  If you are unsure about these entries, contact your Systems Adminis-
trator. 

• Logon Information: Requires the user id and password for the account on the 
Insight Server.

Figure 9 - Test Account Settings

Once the user id and password have been configured, select the “Test Account Settings” 
button.  Upon success the above window is displayed as shown in Figure 9. 
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Figure 10 – Connection tab properties

Connections

The Connections tab allows the user to configure the properties used in connecting to the mail 
server(s). Server Port Numbers allow you to configure the port settings for the Incoming Server 
(IMAP), Outgoing Server (SMTP), and Registration Server (HTTP).  

• Incoming Server (IMAP)

Sets the port configuration used by the Insight Connector for receiving e-mail via 
IMAP.
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Use secured connection (SSL): Provides the option to enable Secure Sockets 
Layer (SSL) for the IMAP connection. Selecting the SSL option automatically up-
dates the port to the default 993 that is used by Insight Server.

Use Persistent Connection: We recommend selecting Use Persistent Connec-
tion unless instructed otherwise by your System Administrator.

Outlook can be configured to connect to the Insight Server for each individual 
IMAP transaction or it can maintain a single persistent connection. A persistent 
connection maintains a constant conversation with the IMAP server. A persistent 
connection is the recommended option as it provides better performance be-
cause Outlook and the Server perform the authentication process only once. 

If Persistent connection is not selected Outlook will need to authenticate with the 
Server each time it needs to submit an IMAP transaction to the Server. Since 
servers typically have a limited number of connections that they can service, a 
non-Persistent connection might be preferable in an environment when there is a 
large number of Outlook clients connecting to the Insight Server

Port:  The Incoming Server port number.

• Outgoing Server (SMTP) 

Sets the port configuration used by Insight Connector 3 for sending e-mail via 
SMTP.  The following three options allow you to configure the exact level of se-
curity used by Insight Connector when sending e-mail.

Use secured connection (SSL): Insight Connector 3 must send e-mail via the 
SMTPS protocol.  This option requires the listener to be enabled on the Insight 
Server and is the least used since the introduction of Transaction Layer Security. 

Use Transaction Layer Security (TLS): TLS has the features of SSL encryption 
of both authentication and data sequences while still running over SMTP. TLS is 
enabled in Insight Server in the default configuration making it the preferred SSL 
encryption method.

Port:  The Outgoing Server port number.

• SMTP Authentication

SMTP server requires Authentication: This is used when sending e-mail from 
a client using an IP address not specified by the $mynetworks configuration pa-
rameter in the Postfix configuration of Insight Server.  For example, if you want to 
connect to the Insight Server via a dial-up connection over the Internet.  If you 
are not running on the local network that your Insight Server is on, you need to 
enable this option to send e-mail through Insight Server.  For additional informa-
tion please contact your Bynari Insight Server Administrator.

SMTP Authentication is plain text. To encrypt the user id & password authentica-
tion, enable Use Transaction Layer Security (TLS).

Use Same Authentication as Incoming Server: Your e-mail login and pass-
word that you entered while setting up your account is used to authenticate with 
the Insight Server when sending e-mail.

Use SMTP Authentication: SMTP Authentication is most often required when 
sending via SMTP to Insight Server from an external IP address.  Enabling this 
parameter tells the client to authenticate with the server to relay messages to ex-
ternal domains.  The default is to use the same user id and password used in re-

20

Revision date: 4/27/06



  Insight Connector Installation and Configuration Guide
trieving e-mail via IMAP.  You can also specify a separate User id and password 
combination.

• Auto Registration Port

This option is enabled by default and allows IC3.1 to verify licensing via the local 
Insight Server.  This is to avoid requiring each individual user to enter the license 
key upon deployment.  Please contact your Insight Server administrator before 
modifying these entries.

Port:  The port number can be modified to match the configuration of the Insight 
Server Apache service.  

SSL:   Provides the option to enable Secure Sockets Layer (SSL) for the license 
registration connection.  This is allows users to still use this feature in environ-
ments where administrators will only allow secure connections to the server.

Note:  The “Auto Registration Port” feature should be disabled if you are not using 
Insight Server v4.2.3 or above.  With this option disabled, IC3 will use the internet 
to register the license via Bynari’s license key server.
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Figure 11 – Folder  tab properties

Folders

The Folders tab allows the user to configure the default behavior of IMAP folder use by the Con-
nector.

• Folder Type

This option is enabled by default and allows the Connector to use custom IMAP 
folder ACL’s to specify the specialized folder types used by Outlook.  These are 
Appointment,  Contact,  Task,  Notes,  and  Mail.   This  option  increases  perfor-
mance since the Connector no longer has to locate the hidden synchronization 
message to determine a given folder’s type.  
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• Folder List

Show All Folders: This is enabled in the default of configuration of the “Folder 
List” which tells the connector to automatically subscribe to all folders found in 
IMAP.

Show Only Subscribed Folders:  In larger environments, the default is not al-
ways desirable.  This is especially the case when there is a large folder needed 
by most but not all users on a server.  

Using this option allows the user to individually select only the specific folders 
they would like to see in Outlook.

Note:  Be sure not to unsubscribe the default Outlook folders (i.e.: Calendar, Con-
tacts, Deleted Items, Drafts, Journal, Sent Item, Notes, Outbox and Tasks).  When 
these folders are not subscribed, Outlook will automatically recreate these folders 
on the IMAP server.
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         Figure 12 Send/Receive tab properties

Send/Receive

The Send/Receive tab allows the user to control the Connector’s default behavior when sending 
and receiving messages to the IMAP folders.

• Download Headers Only:  This option is enabled by default for performance reasons. 
Downloading headers only allows the Connector to build the message list for Outlook 
more rapidly than if it had to download the complete message before providing this infor-
mation to Outlook.  Once the message is selected for viewing then the entire message is 
downloaded.
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• Show progress indicator when loading messages: Allows you to configure the status 

indicator bar when sending and receiving email messages.  The default is 50 messages. 
Any folder with less than 50 messages will not show the Insight Connector status indica-
tor.  The threshold can be changed to show the indicator for every folder with even just 
one message.  

• Indicator threshold (number of messages): Allows a user to configure the folder list 
the Connector checks for new messages when the Send/ Receive button is selected. 
The radio button allows the user to either select specific folder (Inbox is the only one 
checked by default) or the entire folder list.  The latter is usually not practical in larger en-
vironments where there are a large number of shared folders.

• Send\Receive checks mail in all folders: All folders are checked for new e-mail mes-
sages.

• Send\Receive checks mail in these folders: Only the selected folders are checked for 
e-mail.

• Automatic Send/Receive period: This checkbox is only viewable in Outlook 98 and 
2000 versions.  In Outlook 2002 (XP) and 2003, this is configured in its normal location in 
the Outlook configuration properties.  The box to the right specifies the number of min-
utes between cycles.
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Figure 13 – Miscellaneous tab properties

Miscellaneous

The Miscellaneous tab has all remaining configuration entries for the Connector.  These options 
are separated into two sections.

• Message Receipt Options

Prompt me before sending a response:  You are notified when a read receipt 
is requested and you can determine whether to send it.

Always send a response: Send a read receipt whenever one is requested. 
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Never send a response: Never send a read receipt whenever one is requested

• Local Cache Options

Default Location: The default location of the local cache is C:\Documents and 
Settings\[window’s user name]\application data\Bynari\Bynari Insight Connector 
3.0\Accounts\[outlook profile name]\[email address]\. The name of the file is Lo-
calcache.db.

Custom Location: The second section is for changing the default location of the 
local cache.  By selecting the second option of “Custom Location”, a user or ad-
ministrator can override the default location of the local cache used by the Con-
nector.  

• Convert Messages

Click this option only if you are using Multi-byte characters such as Hebrew, Chi-
nese, Japanese, etc.  If you are using Latin based language such as German, 
French, English, etc., you do not need to use this option.
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Figure 14 – About tab properties
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About

The About tab provides Insight Connector binary version information as well as licensing and reg-
istration information.  For additional information about registering the product, please go to the 
section titled “Registering the Insight Connector”.   The “Unregister” Button shown can be used to 
reset the Connector’s key registration files.
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Using Insight Connector 3.1
Insight Connector 3.1 provides Outlook with a MAPI transport service that makes connecting to 
an IMAP transparent to the end user.  The following sections describe some of additional dialogs 
introduced by the Connector such as Folder permissions as well as documenting configuration 
changes needed for features such as Free/Busy. 

Folder Refresh

To refresh the folder list within Outlook, simply press the “Refresh Folders” button on the Insight 
Connector toolbar.  This is useful when a new folder is created on the server from another mail 
client, such as Insight WebClient, or if you have recently received permissions to view the con-
tents of a shared folder. 

Note:  Restarting Outlook will automatically refresh the folder list. 

Folder Sharing

Insight Connector allows Outlook users to share personal or public folders with other users that 
reside on the same mail server.  Folders can include calendars, inbox, tasks, contacts, etc. 

With Outlook open

1. Go   Folder List (Figure 15)

            Figure 15 - Select ‘Folder List’ 

2. Next, highlight the folder you would like to share (Figure 16) and select the “Folder” button on 
the Insight Connector toolbar. 
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Figure 16 - Select ‘Folder’ for the folder properties

3. The folder permissions screen will appear as in Figure 17.
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Figure 17 - Insight Connector Folder Options screen

4. Click ‘add’ to add users, enter the user name, using the email id on the Bynari server. The 
user id can be found on the user admin screen of the Bynari server (Figure 18).  Now select 
the permissions for the person that will be viewing this folder.  There are 4 standard pre-de-
fined folder option permissions:

• Administrator (Full rights)

• Guest (Lookup, Read, Set Seen Flag rights)

• Power User (All rights except for ‘Administrator’).

• User (All rights except for ‘Create’, ‘Delete’, and ‘Administrator’)
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Figure 18 - Pre-defined folder permissions

5. You can also set up customized folder permissions, by clicking the ‘Advanced’ button.  You 
will find all the Access Control List (ACL) permissions (Figure 19).

Figure - 19 Advanced Permission

6. Put a check mark next to the permission you would like to assign to a user and click OK.  Ta-
ble 1 shows a list of all the permissions available.

Note: If a user does not have 'Delete' rights, and tries to edit a shared file/contact, 
that user will receive an error upon synchronization saying he does not have 
delete rights to that folder.  This is because when you edit a document or contact, 
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the old file has to be deleted before the new one can be uploaded.  This is an 
RFC ACL standard. 

Table 1 Access Control List Permissions

Permissions Description

Lookup The user may see that the mailbox exists. 

Read The user may read the mailbox. The user may select the mailbox, 
fetch data, perform searches, and copy messages from the mailbox. 

Insert The user may insert new messages into the mailbox

Set Seen Flag Keep per-user seen state. The "Seen" and "Recent" flags are pre-
served for the user. 

Write The user may modify flags and keywords other than "Seen" and 
"Deleted" (which are controlled by other sets of rights). 

Post 
The user may send mail to the submission address for the mailbox. 
This right differs from the "Insert" right in that the delivery system in-
serts trace information into submitted messages. 

Create The user may create new sub-mailboxes of the mailbox, or delete or 
rename the current mailbox. 

Delete The user may store the "Deleted" flag and perform expunges. 

Administrator The user may change the ACL on the mailbox. 

7. Repeat steps 1-6 as necessary to add other users to whom you wish to share a folder. 

8. Select OK on the Insight Connector Folder options dialog box to accept the newly defined 
permissions.  

Viewing Shared Folders

Other users' shared folders will appear under ‘Other Users’ in the folder list (Figure 20) . 

Figure 20 “Other Users” shared folder list

Public folders created on InsightServer will show up under ‘Shared Folders’ in Outlook 
(Figure 21). 
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Figure 21 “Shared Folders” public folder list

Note: Beginning with Insight Connector 3.0.7 private events (appoint-
ments, contacts, and tasks) are stored on the server. Only the folder owner 
will see private events, no matter the folder permission given to other 
users. 

In order to utilize this functionality safely, be sure to update all clients to 
v3.0.7 or above to ensure that private events are not inadvertently seen by 
other users. 

Also if you are using Insight WebClient, please upgrade to version 4.2.2 or 
better, which also supports private events. 

Older versions of Insight Connector (3.0.6 or older) or Insight WebClient 
(4.2.1 or older) cannot distinguish an event from being private and will dis-
play them all.
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Free/Busy Configuration

Outlook allows users to share free/busy information from their Calendars with other users 
on their mail server. With the Microsoft Office Internet Free/Busy Service, users can pub-
lish their free/busy times to a shared Internet location. Members of the service can view 
each other's free/busy information and can help control which members have access to 
their information.

To configure Free/Busy:

1. Select Tools-> Options-> Calendar Options. Under Advanced options, deselect the 
When sending meeting requests over the Internet, use iCalendar format option 

2. Select  Free/Busy Options (Figure 22). 

Figure 22 Uncheck “When sending meeting…”

3. Enter the following information as shown in Figure 23.

-Options: You can choose how often and for how long free/busy information are 
valid.  We recommend 2 months of Free/Busy information and 1-5 minute auto-
matic updates. 

-Publish at my location: This option must be checked. Enter the FTP address 
as well as the username and password (Outlook 98 and 2000 only). In the figure 
showing Free/Busy Options, a sample path name is shown. Insert your informa-
tion in place of the variables.  Outlook 98/2000 Example:

 ftp://jdoe:mypassw0rd@mail.example.net/freebusy/%NAME%.vcf

Outlook 2002/2003 Example:

 ftp://mail.example.net/freebusy/%NAME%.vcf

-Search Location:  Enter in the URL for the free/busy times of the shared Inter-
net location. In the figure showing Free/Busy Options, a sample path name is 
shown. Insert your information in place of the variables. Example:

http://mail.example.net /freebusy/%NAME%.vcf

Note: Both of the above URL locations consist of the server’s IP address or 
Fully Qualified Domain Name.  For additional details please contact your In-
sight Server Administrator. 
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Figure 23 Free/Busy Options

4. Click “OK” on the Free/Busy options dialog box to apply the settings. 

Show / Hide Toolbar 
In Outlook you have the option to show or hide the Insight Connector toolbar initially set during 
the installation.  Change this setting by selecting from the menu bar, View > Toolbars > Insight 
Connector.  This will place a check mark next to the name to show that it is enabled.

 
Figure 24 Show/Hide Insight Connector Toolbar

If you have hidden the Insight Connector toolbar at the time of installation, you can show the toolbar by 
following the above steps.

37

Revision date: 4/27/06



  Insight Connector Installation and Configuration Guide

Registering the Insight Connector
Insight Connector should automatically register when entering the license key as described in 
section 1.  If the product fails to register, manual validation may be required.

Normally the license key is passed via the Internet, through port 80, to the Bynari Key Validation 
Servers.  The key is then checked, and if valid the product is registered, (You can ping http://reg-
ister.bynari.net to check for connectivity).

Note:  If the workstation resides behind a firewall and port 80 is blocked, port 3080 can 
be configured for automatic registration and validation of the license key.

To manually validate a license key:

1. Ensure that the License Key dialogue box is opened. This is opened during the installation or 
by clicking “About” (from the Insight Connector toolbar)  click “Register”.

2. Ensure that you have your license key entered in the top field (as in section 1).

Figure 25 - Key Support button

3. Click the “Key Support” button (Figure 26).
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Figure 26 - Key Support button

4. Copy and paste the contents of the dialogue box that opens into an e-mail and send 
to Bynari, Inc. Support (The e-mail address can be found at www.bynari.net).

5. A Bynari representative will contact you as soon as possible and provide validation 
information.  Select the checkbox titled “Manually validate the key” and enter the in-
formation provided into the “Key Data” and “Authorization Code” fields (Figure 27).

Figure 27 Manually entering the information

6. Click “OK” to complete the registration process.
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Reporting Problems
When reporting problems, be sure to include the following information:

• Microsoft Windows version number and patch level.

 Right-mouse click the My Computer icon on the Desktop and select Properties. 
The Windows version and patch level will be listed under System: in the General 
tab dialog.

• Microsoft Outlook version and patch level.

 Right-mouse click Help in Outlook and select About Microsoft Outlook. The 
Outlook version and patch level will be listed.

• The full version number of the Insight Connector.

 In Outlook select Inbox from the Folder List then click About in the Connector 
toolbar. The connector version and build number (3.0.7-xxxx) will be listed.
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